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Dragon Anywhere Help
Dragon Anywhere provides you access to the key dictation features from the
Dragon desktop products (Dragon NaturallySpeaking for Windows and Dragon
Dictate for Macintosh.)
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Key Features

Key Features
These are the key features available in Dragon Anywhere.
l

l

l

l

Industry-leading speech recognition that continually adapts to your voice, words and
corrections.
Ability to select text by voice. For example,
l "Select <text>"
l "Select <text> to <text>"
l "Select all"
l "Unselect that"
Navigate text by voice. For example,
l "Go to beginning/end"
l "Insert after <text>"
l "Resume with <text>"
l "Go to end of sentence/paragraph"
Apply formatting by voice. For example,
l "Bold that"
l "Underline that"
l "Italicize that"
l "Set text color to <color>"

Document management
l

l
l
l

Share your dictation. Email your documents or save them to a cloud storage service
using the apps you have installed on your device.
Import existing documents you want to extend or edit by voice.
Save your dictation as an Evernote note.
Open in dictation in Microsoft Word.
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Customization
l

l

Import custom words from Dragon desktop or add words on your mobile device that
will be synced with the latest versions of Dragon desktop.
Generate text blocks with a single utterance. You can import auto-texts from Dragon
desktop or create auto-texts on your mobile device that will be synced with the latest
versions of Dragon desktop.

See also
l
l
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Architecture

Architecture
Dictation workflow
When you dictate in Dragon Anywhere, your audio is encrypted and transmitted to
our recognition servers in a secure data center. The audio is converted to text,
which is sent to your device. The audio for commands you speak is also sent to
our servers and the resulting action is communicated to Dragon Anywhere.
Dragon Anywhere does not access content on your device, such as your contacts
or your location.
You must have an active internet connection to perform dictation as well as most
actions. The app makes minimal use of your internet connection. Approximately 6
kb/s are used to transfer your audio to our servers.

Custom words and auto-texts
The custom words and auto-texts you create or import are uploaded to our central
server.

Help
The help pages are served from our server.

Documents
The documents you dictate are stored locally on your device. You can view your
documents and edit them with the keyboard even when you're not connected to
the internet. You can share your documents via email or cloud storage and
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communication apps if you're connected to the internet. To access a document
from multiple devices, you must share the document to a cloud storage service.

Sharing content with Dragon desktop
Watch a video tutorial on this topic.
If you're using a version of Dragon desktop products or Dragon for Mac that connects to the central management server in the cloud, you can share custom words
and auto-texts between Dragon Anywhere on your mobile device and Dragon
desktop on your Windows or Macintosh PC.
To enable the connection, enter your Dragon Anywhere username and password
in Dragon desktop. The desktop product will then upload custom words and autotext commands to the central server where Dragon Anywhere can access them.
The desktop product will also download any custom words or auto-text commands you've added in Dragon Anywhere. The download may not occur immediately after adding a word or auto-text. Consult the Dragon desktop help for
further details.
Note: Dragon Anywhere does not support word properties you've defined in
Dragon desktop.
Note: Dragon Anywhere supports plain text auto-texts.

Using multiple devices
You can use Dragon Anywhere on multiple mobile devices where you've
installed the app. When you log in with your username and password, your custom words and auto-texts will be retrieved from the central server. Therefore, you
will receive the same recognition experience on all of your devices.
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Multiple speakers on one device
Dragon Anywhere adapts to your voice and word usage. You should not allow
other people to dictate when you are logged in with your username. Allowing
other people to dictate will degrade your accuracy. Each speaker needs his or her
account. Tap here for further details.
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Maximize your accuracy
First impressions
If you experience recognition errors in the first few minutes, keep dictating. The system
will adapt to your voice after a few minutes. This adaptation phase is particularly important
if you speak with an accent.

Microphone control
Tap the Microphone to turn it on.

Dictate when the microphone is green.
The microphone remains On until you turn it Off or say "Microphone Off", leave the Dictation window or switch to another app. If the microphone is left on without receiving audio,
it will turn off automatically after 20 seconds.

Audio tips
l

l
l
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Don't allow other people to dictate with your account. The system adapts to your
voice, allowing other people to dictate into your profile will degrade your accuracy.
Read more details here.
Hold your mobile device 6 to 18 inches from your mouth.
Locate the microphone on your device and avoid placing your hand or a protective
case over the microphone while you dictate.

Maximize your accuracy

l

l

l

Dictate at a normal volume and pace. Avoid yelling, talking slowly or saying one
word at a time.
Remember that unless you turn off the microphone, Dragon Anywhere will record
everything it hears. When you complete a portion of dictation, turn off the microphone or say "Microphone Off."
Minimize the amount of background noise. If you can't avoid background noise, consider connecting a microphone to your mobile device, such as the ear bud microphone included with your phone.

Dictation tips
If you're new to dictation, the key is to pronounce your words clearly and to have a rough
idea about what you want to say before you start, so that you can speak in full sentences
with minimal pauses.
Dragon Anywhere includes an explicit command syntax to perform dictation, selection, correction and command and control activities. Refer to the Commands List in the Dictation
scene for a quick look at the most common commands. To see all supported commands,
just say "What Can I Say" in the Dictation scene or access the What Can I Say item on the
Sidebar.
If Dragon Anywhere makes an error or you want to change something, wait until you finish your current sentence, paragraph or document; then you can proofread and make corrections or edits as required.
Remember to speak punctuation marks you want to appear in your document. Consult the
names for common punctuation symbols.
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Selecting text
Use voice commands to select dictated or typed text and correct, replace, delete or format
the text. These commands select the closest instance of the specified text to the left of the
current cursor position. You can select single words, phrases, whole sentences or punctuation marks. For example:
Say "client is a thirty year old male with a history of depression period"
The recognized text: Client is a 30-year-old male with a history of depression.
Say "select thirty year old male"
The selected text: Client is a 30-year-old male with a history of depression.
To select longer text passages, use the "through" command to select text from the first to
the last word of your required selection. For example:

Using the text above, say "select client through history"
The selected text: Client is a 30-year-old male with a history of depression.
Once text is selected (via voice command), you can replace, delete or format the selected
text.
To move between instances of the same text, say "Select next" or "Select previous."

Auto-formatted text
Dragon Anywhere will format some text automatically. For example, dates, times, measurements and numbers.
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Say

To get

January first two thousand fifteen

January 1, 2015

oh one oh one two thousand fifteen

01/01/2015

ten o'clock am

10:00 am

50 milligrams

50 mg

Customizing the vocabulary
Dragon Anywhere maintains a large vocabulary of words and phrases, but it may not contain words specific to your industry, clientele or social network. If you dictate words that
are not recognized correctly, you can extend the vocabulary by adding individual words or
by importing a word list from Dragon desktop.
If the system recognizes a word that you are unlikely to use in your dictation, select the
word and say "Do not recognize that word" to prevent the word from being recognized in
the future.

Additional dictation topics
Click

To learn about

Adding lines and spaces

Dictating line breaks and spaces as you go.

Dictating punctuation

Dictating punctuation as you go

11

PDF GUIDE A

Click

To learn about

Fixing mistakes

Making corrections to misrecognitions or editing your
own ideas

Adding emphasis to text

Adding bold, underline, italics, or color to your text

Using the keyboard

Enter or edit text with the keyboard.

Adding photos

Insert an existing photo or take a new photo with the camera.
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Editing text
You can edit text by voice or with touch and the keyboard.
You may find that a combination of voice and touch works best.

Control the cursor by voice.
Say

To

Go to beginning | end

Move cursor to the beginning or end of the text.

Go to end of sentence
| paragraph

Move cursor to the end of the current sentence or paragraph.

Go back

Return cursor to the location before the last formatting or correction command was issued.

Go to title

Place cursor in the Title field.

Go to dictation

Place cursor in the Dictation field.

Select text by voice.
Say

To

Select <text>

Select the specified text.

Unselect That

Unselect the previously selected text.

Select <text> Through
<text>

Select a range of text.
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Say

To

Select All

Select all the text in the editor.

Select Previous | Next

Select the previous or next instance of the selected text.

Select (previous | next)
(first | last) (sentence | Select the specified segment of text.
paragraph)
Delete Word

Select a word and then say "Delete Word" to remove it from
the document.

Format text by voice.
In addition to using voice commands, you can format text by touch. Long-tap the text you
want to format, adjust the selection as needed using the text handles and then tap a formatting option on the Edit menu, such as Bold, Italic or Underline.
Note: You must select text before formatting it. For example, say "Select <text>" and then
say "Bold that." A formatting command does not automatically apply to the last thing you
said, as it does in the Dragon desktop products.
You can apply bold, italic, underline, color and highlights to your text with voice commands.
Say "Client failed to appear for the hearing on June 15 period"
Say "Select failed to appear"
Say "Underline that"
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Editing text

Recognized text: Client failed to appear for the hearing on June 15.
Say

To

Bold That

Bold the selected text.

Italicize That

Italicize the selected text.

Underline That

Underline the selected text.

Set Text Color to
<color>

Change the selected text to a color: red, green, yellow, blue,
black, white, clear

Set Highlight Color to
<color>

Highlight the selected text: red, green, yellow, blue, black,
white, clear

Undo That

Remove the last text change you made. This command does not
apply to text formatting. Use the Unformat That command
instead.

Redo That

Re-apply the last text change you made. This command does
not apply to text formatting. Use the Unformat That command
instead.

Unformat That

Remove formatting from the selected text.
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Sharing and saving a document
Share your dictated text with your other devices or colleagues.

To share dictation
1. On the Dictation screen, do one of the following to open the Sharing window:
l

l

Say "Email document," "Email as Attachment," "Share document" or "Save
to Evernote."
Tap Sharing
and select "Email document," "Email as Attachment," "Share
document" or "Save to Evernote."

2. If you select either of the email options, a new email message appears. Enter the
recipient's email address.
The "send from" account is based on the default email account defined on your
device.
3. If you select "Share document," you can choose from any cloud storage app on your
device (iCloud, Dropbox, Box, etc.) to store an .rtf, Microsoft Word, .rtfd or .txt
copy of your dictation.
4. If you have the Microsoft Word app installed, you can choose the Open in
Word/Copy to Word options from the Share menu to have your dictated text opened
in Microsoft Word. You can then save your document from Microsoft Word.
Note: You can define a default email recipient for the Email Document command in the settings.
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Sharing and saving a document

Note: You can indicate the default format for sharing documents in the settings.

To transfer text to another app
Rather than sending your dictation as an email or a document, you may want to transfer
your dictated text to another app via the copy and paste functions available in your device's
operating system. This procedure is useful for replying to an email or an instant message or
pasting text into a workflow app.
1. Dictate the text you plan to transfer into another app.
2. Say "Transfer Text."
A confirmation message appears indicating your text has been copied.
3. Use your device's function to switch to the target app, such as double-tapping the
Home button.
4. Long-tap in the target app and choose Paste from the pop-up menu.

See also
Importing text or documents
Setting up sharing apps
Sharing with Evernote
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Controlling the app by voice
You can perform many actions by voice rather than touch. The voice commands allow you
to perform tasks faster than tapping multiple items on the screen. You can say these commands on the Dictation scene when the microphone is turned on.
Say "What Can I Say" for a complete list of commands.

Say

To

Give me help

Open the help pages.

New document

Save the current document and create a new, blank document.

Share document

Open the Share menu to pick a cloud storage or communication service.

Import document

Load an RTF, RTFD, DOCX, TXT or HTM file from
cloud storage.

Open in Word

Load your dictation in the Microsoft Word app installed on
your device.

Save to Evernote

Save your dictation as a new note in your Evernote account.

Email document

Open a new email message with your dictated text placed in
the message body.

Email document as attach- Open a new email message with your dictated text attached
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Say

To

ment

as an RTF, DOCX or TXT attachment.

Open documents

Open the Documents screen to view and share your documents.

Show my words

Open the Words screen to view and add custom words.

Show my auto-texts

Open the Auto-texts screen to view and add text macros.

Add that to vocabulary

Add the selected word to the vocabulary by opening the
Manage Words page.

Show keyboard

Display the operating system keyboard.

Show settings

Open the Settings screen.

Log me out

Close the current session and return to the Login screen.
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Already a Dragon user?
Click

To learn about

"Dragon Anywhere-specific commands" on
page 46

Commands that are unique to Dragon
Anywhere.

"Commands shared with Dragon desktop"
on page 41

Commands shared with Dragon desktop
products and Dragon for Mac.

"How Dragon Anywhere behaves differently Some limitations on formatting comthan Dragon Desktop" on page 25
mands with Dragon Anywhere.
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Dragon Anywhere-specific commands
Dragon Anywhere commands
You can use voice commands in Dragon Anywhere to perform most actions. Here’s how:
Say

To

New Document

Start a new document.

Open Documents

Open the Documents window.

Go To Title

Move the insertion point to the Title field of your dictation,
where you can assign a file name.

Go To Dictation

Move the insertion point to the Body field.

Share Document

Send dictation via text, email, social media or a storage app.

Email Document

Open your email program and insert your current dictation.

Email as Attachment

Send your dictation as an RTF, Microsoft Word. or TXT email
attachment.

Open Settings

Open the Settings window.

Transfer Text

Select all text in the Dictation window and copy it to the clipboard so you can paste it into another app.

Switch to <language>

Change the dictation language. For example, "Switch to German."
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Say

To

Show Keyboard

Open the keyboard.

Import Document

Import a document to use in Dragon Anywhere.

Show My Auto-texts

Show your auto-texts.

Show My Words

Show your list of custom words.

Choose Photo

Select a photo to add to your dictation.

Take a Photo

Take a photo to add to your dictation.

Give Me Help

Open the help pages.

Say “What Can I Say” to see the complete commands list.
See also
l
l

22

"How Dragon Anywhere behaves differently than Dragon Desktop" on page 25
"Commands shared with Dragon desktop" on page 41

Commands shared with Dragon desktop

Commands shared with Dragon desktop
These commands function in Dragon Anywhere as well as in Dragon desktop products and
Dragon for Mac:
Familiar commands
New Line | New Paragraph
Undo That | Redo That
Select Previous | Next
Select (This | Previous | Next | First | Last) (Word | Sentence | Paragraph)
Select | Unselect <text>
Resume With
Cap <text> (to start the next word you dictate with a capital letter)
No Space
Spacebar
Numeral | Roman Numeral
Microphone off | Stop Listening
Bold | Underline | Italicize That
Scratch That | Delete That
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Familiar commands
Tab Key
Select All
Select | Unselect That
Insert Before | After
Go to Beginning | End
All Caps That (to apply all capital letters to selected text)
What Can I say (to display commands)
Give Me Help

See also
l
l
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"Dragon Anywhere-specific commands" on page 46
"How Dragon Anywhere behaves differently than Dragon Desktop" on the facing
page

How Dragon Anywhere behaves differently than Dragon Desktop

How Dragon Anywhere behaves differently than Dragon Desktop
Unlike Dragon desktop products and Dragon for Mac, Dragon Anywhere requires text to
be selected before it can be formatted. A command, like "Bold That," will not be applied
automatically to the last thing you said. Select the text first, by saying "Select Text" or
"Select last word" and then say a formatting command, such as "Underline That."
The Undo That command in Dragon Anywhere will undo recognized text but it will not
undo formatting. To undo a formatting command by voice, select the text and issue the
"Unformat That" command. For example,
Say "Select <text>"
Say "Bold That"
Say "Select <text>"
Say "Unformat That"
The text will no longer have bolding.
See also
l
l

"Dragon Anywhere-specific commands" on page 46
"Commands shared with Dragon desktop" on page 41
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Maximize your accuracy
First impressions
If you experience recognition errors in the first few minutes, keep dictating. The system
will adapt to your voice after a few minutes. This adaptation phase is particularly important
if you speak with an accent.

Microphone control
Tap the Microphone to turn it on.

Dictate when the microphone is green.
The microphone remains On until you turn it Off or say "Microphone Off", leave the Dictation window or switch to another app. If the microphone is left on without receiving audio,
it will turn off automatically after 20 seconds.

Audio tips
l

l
l
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Don't allow other people to dictate with your account. The system adapts to your
voice, allowing other people to dictate into your profile will degrade your accuracy.
Read more details here.
Hold your mobile device 6 to 18 inches from your mouth.
Locate the microphone on your device and avoid placing your hand or a protective
case over the microphone while you dictate.

Maximize your accuracy

l

l

l

Dictate at a normal volume and pace. Avoid yelling, talking slowly or saying one
word at a time.
Remember that unless you turn off the microphone, Dragon Anywhere will record
everything it hears. When you complete a portion of dictation, turn off the microphone or say "Microphone Off."
Minimize the amount of background noise. If you can't avoid background noise, consider connecting a microphone to your mobile device, such as the ear bud microphone included with your phone.

Dictation tips
If you're new to dictation, the key is to pronounce your words clearly and to have a rough
idea about what you want to say before you start, so that you can speak in full sentences
with minimal pauses.
Dragon Anywhere includes an explicit command syntax to perform dictation, selection, correction and command and control activities. Refer to the Commands List in the Dictation
scene for a quick look at the most common commands. To see all supported commands,
just say "What Can I Say" in the Dictation scene or access the What Can I Say item on the
Sidebar.
If Dragon Anywhere makes an error or you want to change something, wait until you finish your current sentence, paragraph or document; then you can proofread and make corrections or edits as required.
Remember to speak punctuation marks you want to appear in your document. Consult the
names for common punctuation symbols.
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Selecting text
Use voice commands to select dictated or typed text and correct, replace, delete or format
the text. These commands select the closest instance of the specified text to the left of the
current cursor position. You can select single words, phrases, whole sentences or punctuation marks. For example:
Say "client is a thirty year old male with a history of depression period"
The recognized text: Client is a 30-year-old male with a history of depression.
Say "select thirty year old male"
The selected text: Client is a 30-year-old male with a history of depression.
To select longer text passages, use the "through" command to select text from the first to
the last word of your required selection. For example:

Using the text above, say "select client through history"
The selected text: Client is a 30-year-old male with a history of depression.
Once text is selected (via voice command), you can replace, delete or format the selected
text.
To move between instances of the same text, say "Select next" or "Select previous."

Auto-formatted text
Dragon Anywhere will format some text automatically. For example, dates, times, measurements and numbers.
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Say

To get

January first two thousand fifteen

January 1, 2015

oh one oh one two thousand fifteen

01/01/2015

ten o'clock am

10:00 am

50 milligrams

50 mg

Customizing the vocabulary
Dragon Anywhere maintains a large vocabulary of words and phrases, but it may not contain words specific to your industry, clientele or social network. If you dictate words that
are not recognized correctly, you can extend the vocabulary by adding individual words or
by importing a word list from Dragon desktop.
If the system recognizes a word that you are unlikely to use in your dictation, select the
word and say "Do not recognize that word" to prevent the word from being recognized in
the future.

Additional dictation topics
Click

To learn about

Adding lines and spaces

Dictating line breaks and spaces as you go.

Dictating punctuation

Dictating punctuation as you go
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Click

To learn about

Fixing mistakes

Making corrections to misrecognitions or editing your
own ideas

Adding emphasis to text

Adding bold, underline, italics, or color to your text

Using the keyboard

Enter or edit text with the keyboard.

Adding photos

Insert an existing photo or take a new photo with the camera.
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Maximize your accuracy
First impressions
If you experience recognition errors in the first few minutes, keep dictating. The system
will adapt to your voice after a few minutes. This adaptation phase is particularly important
if you speak with an accent.

Microphone control
Tap the Microphone to turn it on.

Dictate when the microphone is green.
The microphone remains On until you turn it Off or say "Microphone Off", leave the Dictation window or switch to another app. If the microphone is left on without receiving audio,
it will turn off automatically after 20 seconds.

Audio tips
l

l
l

Don't allow other people to dictate with your account. The system adapts to your
voice, allowing other people to dictate into your profile will degrade your accuracy.
Read more details here.
Hold your mobile device 6 to 18 inches from your mouth.
Locate the microphone on your device and avoid placing your hand or a protective
case over the microphone while you dictate.
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l

l

l

Dictate at a normal volume and pace. Avoid yelling, talking slowly or saying one
word at a time.
Remember that unless you turn off the microphone, Dragon Anywhere will record
everything it hears. When you complete a portion of dictation, turn off the microphone or say "Microphone Off."
Minimize the amount of background noise. If you can't avoid background noise, consider connecting a microphone to your mobile device, such as the ear bud microphone included with your phone.

Dictation tips
If you're new to dictation, the key is to pronounce your words clearly and to have a rough
idea about what you want to say before you start, so that you can speak in full sentences
with minimal pauses.
Dragon Anywhere includes an explicit command syntax to perform dictation, selection, correction and command and control activities. Refer to the Commands List in the Dictation
scene for a quick look at the most common commands. To see all supported commands,
just say "What Can I Say" in the Dictation scene or access the What Can I Say item on the
Sidebar.
If Dragon Anywhere makes an error or you want to change something, wait until you finish your current sentence, paragraph or document; then you can proofread and make corrections or edits as required.
Remember to speak punctuation marks you want to appear in your document. Consult the
names for common punctuation symbols.
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Selecting text
Use voice commands to select dictated or typed text and correct, replace, delete or format
the text. These commands select the closest instance of the specified text to the left of the
current cursor position. You can select single words, phrases, whole sentences or punctuation marks. For example:
Say "client is a thirty year old male with a history of depression period"
The recognized text: Client is a 30-year-old male with a history of depression.
Say "select thirty year old male"
The selected text: Client is a 30-year-old male with a history of depression.
To select longer text passages, use the "through" command to select text from the first to
the last word of your required selection. For example:

Using the text above, say "select client through history"
The selected text: Client is a 30-year-old male with a history of depression.
Once text is selected (via voice command), you can replace, delete or format the selected
text.
To move between instances of the same text, say "Select next" or "Select previous."

Auto-formatted text
Dragon Anywhere will format some text automatically. For example, dates, times, measurements and numbers.
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Say

To get

January first two thousand fifteen

January 1, 2015

oh one oh one two thousand fifteen

01/01/2015

ten o'clock am

10:00 am

50 milligrams

50 mg

Customizing the vocabulary
Dragon Anywhere maintains a large vocabulary of words and phrases, but it may not contain words specific to your industry, clientele or social network. If you dictate words that
are not recognized correctly, you can extend the vocabulary by adding individual words or
by importing a word list from Dragon desktop.
If the system recognizes a word that you are unlikely to use in your dictation, select the
word and say "Do not recognize that word" to prevent the word from being recognized in
the future.

Additional dictation topics
Click

To learn about

Adding lines and spaces

Dictating line breaks and spaces as you go.

Dictating punctuation

Dictating punctuation as you go

34

Maximize your accuracy

Click

To learn about

Fixing mistakes

Making corrections to misrecognitions or editing your
own ideas

Adding emphasis to text

Adding bold, underline, italics, or color to your text

Using the keyboard

Enter or edit text with the keyboard.

Adding photos

Insert an existing photo or take a new photo with the camera.
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Dictating with a Bluetooth® microphone
(Android)
Dragon Anywhere supports dictation with Bluetooth microphones on Android devices.
1. Enable Bluetooth in the Android settings.
2. Pair your Bluetooth microphone with your Android device.
3. Switch to Dragon Anywhere and long-tap the microphone control to display the
microphone icons.

4. Tap the small Bluetooth icon.
The icon in the middle of the microphone control changes to the Bluetooth symbol
and a confirmation message appears indicating Dragon Anywhere is listening to the
Bluetooth microphone.
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Dictating with a Bluetooth® microphone (Android)

5. To switch back to the built-in microphone, long-tap the microphone control again
and tap the small microphone icon.

Dragon Anywhere remembers your Bluetooth microphone across sessions.

While using your Bluetooth microphone remain within 30 feet of your Android device and
maintain sufficient battery charge in your Bluetooth microphone.
If Dragon Anywhere no longer detects your Bluetooth microphone, it switches to the builtin microphone and displays an error message. To resume using a Bluetooth microphone,
ensure the Bluetooth microphone is connected to your device and follow the steps outlined
above.
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Commands List
Dragon Anywhere includes an explicit command syntax to perform dictation, selection, correction and command and control activities. Refer to the Commands List in the Dictation
scene for quick access to the most common commands.
To see all supported commands, just say "What Can I Say" in the Dictation scene or access
the What Can I Say item on the Sidebar

.

To access the Commands List
1. In the Dictation scene, tap the Commands List icon
.
2. Scroll the list, if needed, to see all commands.
3. Tap the "View all commands" link to open the What Can I Say content that contains
all supported commands, including auto-texts you have added to the system.
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Controlling the app by voice
You can perform many actions by voice rather than touch. The voice commands allow you
to perform tasks faster than tapping multiple items on the screen. You can say these commands on the Dictation scene when the microphone is turned on.
Say "What Can I Say" for a complete list of commands.

Say

To

Give me help

Open the help pages.

New document

Save the current document and create a new, blank document.

Share document

Open the Share menu to pick a cloud storage or communication service.

Import document

Load an RTF, RTFD, DOCX, TXT or HTM file from
cloud storage.

Open in Word

Load your dictation in the Microsoft Word app installed on
your device.

Save to Evernote

Save your dictation as a new note in your Evernote account.

Email document

Open a new email message with your dictated text placed in
the message body.

Email document as attach- Open a new email message with your dictated text attached
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Say

To

ment

as an RTF, DOCX or TXT attachment.

Open documents

Open the Documents screen to view and share your documents.

Show my words

Open the Words screen to view and add custom words.

Show my auto-texts

Open the Auto-texts screen to view and add text macros.

Add that to vocabulary

Add the selected word to the vocabulary by opening the
Manage Words page.

Show keyboard

Display the operating system keyboard.

Show settings

Open the Settings screen.

Log me out

Close the current session and return to the Login screen.
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Commands shared with Dragon desktop
These commands function in Dragon Anywhere as well as in Dragon desktop products and
Dragon for Mac:
Familiar commands
New Line | New Paragraph
Undo That | Redo That
Select Previous | Next
Select (This | Previous | Next | First | Last) (Word | Sentence | Paragraph)
Select | Unselect <text>
Resume With
Cap <text> (to start the next word you dictate with a capital letter)
No Space
Spacebar
Numeral | Roman Numeral
Microphone off | Stop Listening
Bold | Underline | Italicize That
Scratch That | Delete That
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Familiar commands
Tab Key
Select All
Select | Unselect That
Insert Before | After
Go to Beginning | End
All Caps That (to apply all capital letters to selected text)
What Can I say (to display commands)
Give Me Help

See also
l
l
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"Dragon Anywhere-specific commands" on page 46
"How Dragon Anywhere behaves differently than Dragon Desktop" on page 25

Editing text

Editing text
You can edit text by voice or with touch and the keyboard.
You may find that a combination of voice and touch works best.

Control the cursor by voice.
Say

To

Go to beginning | end

Move cursor to the beginning or end of the text.

Go to end of sentence
| paragraph

Move cursor to the end of the current sentence or paragraph.

Go back

Return cursor to the location before the last formatting or correction command was issued.

Go to title

Place cursor in the Title field.

Go to dictation

Place cursor in the Dictation field.

Select text by voice.
Say

To

Select <text>

Select the specified text.

Unselect That

Unselect the previously selected text.

Select <text> Through
<text>

Select a range of text.
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Say

To

Select All

Select all the text in the editor.

Select Previous | Next

Select the previous or next instance of the selected text.

Select (previous | next)
(first | last) (sentence | Select the specified segment of text.
paragraph)
Delete Word

Select a word and then say "Delete Word" to remove it from
the document.

Format text by voice.
In addition to using voice commands, you can format text by touch. Long-tap the text you
want to format, adjust the selection as needed using the text handles and then tap a formatting option on the Edit menu, such as Bold, Italic or Underline.
Note: You must select text before formatting it. For example, say "Select <text>" and then
say "Bold that." A formatting command does not automatically apply to the last thing you
said, as it does in the Dragon desktop products.
You can apply bold, italic, underline, color and highlights to your text with voice commands.
Say "Client failed to appear for the hearing on June 15 period"
Say "Select failed to appear"
Say "Underline that"
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Editing text

Recognized text: Client failed to appear for the hearing on June 15.
Say

To

Bold That

Bold the selected text.

Italicize That

Italicize the selected text.

Underline That

Underline the selected text.

Set Text Color to
<color>

Change the selected text to a color: red, green, yellow, blue,
black, white, clear

Set Highlight Color to
<color>

Highlight the selected text: red, green, yellow, blue, black,
white, clear

Undo That

Remove the last text change you made. This command does not
apply to text formatting. Use the Unformat That command
instead.

Redo That

Re-apply the last text change you made. This command does
not apply to text formatting. Use the Unformat That command
instead.

Unformat That

Remove formatting from the selected text.

45

PDF GUIDE A

Dragon Anywhere-specific commands
Dragon Anywhere commands
You can use voice commands in Dragon Anywhere to perform most actions. Here’s how:
Say

To

New Document

Start a new document.

Open Documents

Open the Documents window.

Go To Title

Move the insertion point to the Title field of your dictation,
where you can assign a file name.

Go To Dictation

Move the insertion point to the Body field.

Share Document

Send dictation via text, email, social media or a storage app.

Email Document

Open your email program and insert your current dictation.

Email as Attachment

Send your dictation as an RTF, Microsoft Word. or TXT email
attachment.

Open Settings

Open the Settings window.

Transfer Text

Select all text in the Dictation window and copy it to the clipboard so you can paste it into another app.

Switch to <language>

Change the dictation language. For example, "Switch to German."
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Say

To

Show Keyboard

Open the keyboard.

Import Document

Import a document to use in Dragon Anywhere.

Show My Auto-texts

Show your auto-texts.

Show My Words

Show your list of custom words.

Choose Photo

Select a photo to add to your dictation.

Take a Photo

Take a photo to add to your dictation.

Give Me Help

Open the help pages.

Say “What Can I Say” to see the complete commands list.
See also
l
l

"How Dragon Anywhere behaves differently than Dragon Desktop" on page 25
"Commands shared with Dragon desktop" on page 41
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Dictation languages
You can use Dragon Anywhere to dictate in multiple languages.
The language of the app's user interface is independent from the dictation language. The
user interface language is controlled by the Language you've selected in your device settings. The dictation language and the language of the online help is controlled by the language you select in the Dragon Anywhere settings.

Switching languages from the Dictation window
While you're dictating, you can use voice commands to change the dictation language. For
example, if you currently dictating in US English and you want to switch to German, turn
on the microphone and say, "Switch to German."

Switching languages in the Settings
If you want to switch the dictation language for an extended period of time, you can define
the dictation language in the app settings.
1. Open the Sidebar
and choose Settings.
2. Scroll to the Dictation Settings section and choose your desired language from the
Language list.
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Adding lines and spaces
While dictating, say commands to insert common keyboard actions, including these:
Say

To

New Line

Start a new line. This is the same as pressing the Enter key once.

New Paragraph

Start a new paragraph. This is the same as pressing the Enter key
twice. The next word you speak will be capitalized automatically.

Tab Key

Enter a wide space at the beginning of a line, usually to align
text. This is the same as pressing the Tab key.

Space Bar

Add a space
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Dictating punctuation
As you dictate, remember to say punctuation marks. For example, to dictate "The deadline
for the report is next week, no later than Thursday." say "The deadline for the report is next
week comma no later than Thursday period."
Make sure you pause slightly before and after you dictate punctuation. This way, if you
want to insert a comma and not the word "comma," Dragon Anywhere can more easily
determine your intent.
Below is a list of common punctuation symbols and their names.
To Enter

Say

&

ampersand sign

’

apostrophe

@

at sign

'

begin single quote/ open single quote

"

open quote, begin quote, close quote, end quote

""

empty quotes

\

backslash

:

colon

,

comma (optional)

^

caret
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To Enter

Say

--

dash, em dash

.

dot /point/ period
Great Britain - full stop

$

dollar sign/dollar/ dollars

=

equal sign

!

U.S./Canada only: exclamation point
Other Dialects: exclamation mark

£

U.S./Canada: pound sterling sign
Other Dialects: pound sign pounds

®

registered sign

;

semicolon

(tab)

tab key

_

underscore

{

U.S./Canada: left brace open brace
Other than U.S./Canada: left curly bracket open curly bracket

[

U.S./Canada: left bracket open bracket
Other than U.S./Canada: left square bracket open square bracket

(

All Dialects: left parenthesis open parenthesis Other than
U.S./Canada: left bracket open bracket

<

left angle bracket/ open angle bracket
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To Enter

Say

>

right angle bracket/ close angle bracket

«

open euro quote

-

minus sign

%

percent sign

:-(

frowny face

;-)

winky face

:-)

smiley face

*

asterisk

’s

apostrophe ess

`

back quote

'

close single/quote end single quote

"

close quote, end quote

[]

empty brackets

/

forward slash slash

:

numeric colon

,

numeric comma

...

ellipsis
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To Enter
°

Say
degree sign
U.S./Canada: period (optional)

.
Other than U.S./Canada: full stop (optional)
©

copyright sign

€

euro-sign/euro/ euros

-

hyphen numeric hyphen

?

question mark

§

section sign

(space)

space bar

~

tilde

|

vertical bar
U.S./Canada: close brace right brace

}
Other than U.S./Canada: right curly bracket close curly bracket
U.S./Canada: right bracket close bracket
]
Other than U.S./Canada: right square bracket close square bracket
All Dialects: right parenthesis close parenthesis
)
Other than U.S./Canada: right bracket close bracket
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To Enter

Say

<

less than

>

greater than

»

close euro quote
U.S./Canada: pound sign number sign

#
Other than U.S./Canada: hash sign sharp sign
+
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plus sign

Adding photos

Adding photos
You can add photos to your documents by voice.
1. With a document open and the microphone on, tap to place the cursor where you
want to insert the photo.
l Say "Choose photo" and choose a photo from the Photo library on your
device, or
l Say "Take photo" and use the camera on your device to take a photo.
2. If you are prompted to allow Dragon Anywhere to use the camera on your device,
select Yes or Allow.
3. When you have the photo you want, tap Use. The photo appears where you placed
the cursor in step 1.

Note: If you choose a high resolution photo, the image may extend off the screen to the
right. You will not be able to scroll to the right to see the remainder of the image. When
you share your dictation, the entire photo will be exported.

See also
What can I say
Sharing dictation
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Fixing mistakes
Use these commands to fix mistakes.
Say

To

Undo That

Undo most actions and commands. To undo a text formatting
action, select the text and say, "Unformat That" or say a formatting command, such as "Bold That."
Replace all text after the specified text, with the next thing you
dictate. The command acts on the previous 1000 characters dictated during the current dictation section.

Resume With <text>

For example, you might dictate the words, "Let's meet in the
lobby near the fountain," but then you get a better idea. Change
your suggestion by saying, "Resume With meet." "In the Longfellow conference room."
The final text would be: "Let's meet in the Longfellow conference room."
To change text, select it by voice by saying, "Select <text>" or
by long-tapping the text and adjusting the selection handles. You

Changing text
can then dictate new text or open the keyboard
revised text.
Scratch That
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and type the

Removes the last thing you said. The command can be spoken
multiple times to remove multiple utterances.

Working with documents

Working with documents
As you dictate, your documents are saved automatically on your local device every 5
seconds.

To start a new document
l

Tap New Document
ment."

at the top of the Dictation window or say, "New Docu-

Note: If you are creating draft documents to complete at a later time by initially entering
just a document title, complete the following steps.
1.
2.
3.
4.

Dictate the document title.
Wait for the "Saved" icon to appear in the upper-right corner of the document.
Say "New Document" or tap the New Document icon.
Dictate the title for the next document.
Each document will appear on the Documents page available from the Sidebar. Tap
a document to load it into the Dictation page to dictate the contents of the document.

To open a saved document
1. Open the Sidebar
and choose Documents.
2. Tap a document from the list to open it in the Dictation scene.
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To rename a document
1. Tap the file name on the Dictation window to rename a document. By default, a document is named “Untitled” followed by a number.
2. Do one of the following:
l

To dictate a file name for your document, tap Microphone

l

To type a file name, tap Keyboard

and dictate.

.

To sort documents
Open the Sidebar and choose Documents. Tap "Name" to sort documents alphabetically by
file name, or tap "Date" to sort documents chronologically by the last-saved time stamp.

To delete, share or send a document by email
1. Swipe right-to-left on a document title.
2. Select Delete, Share or Email.
3. Follow the prompts for the option you selected.

To delete one or more documents
1. Tap Select.
2. Select the documents you want to delete.
3. Tap Trash
.
4. Tap Delete to confirm.
Note: Documents you delete on mobile devices cannot be restored.
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See Also:
Importing a document
Sharing and saving a document
Setting up sharing apps
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Importing a document
You can import .docx, .txt, .htm, .rtfd, and .rtf documents by saying “Import Document” or
by using the Import tool

.

You can also import a document by using the Import Document link at the bottom of the
Documents screen.
Note: Not all features available in .docx, .rtfd and .rtf documents are supported, such as
headers and footers. You'll receive a warning message if unsupported content is present in
a document you want to import.
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Sharing and saving a document
Share your dictated text with your other devices or colleagues.

To share dictation
1. On the Dictation screen, do one of the following to open the Sharing window:
l

l

Say "Email document," "Email as Attachment," "Share document" or "Save
to Evernote."
Tap Sharing
and select "Email document," "Email as Attachment," "Share
document" or "Save to Evernote."

2. If you select either of the email options, a new email message appears. Enter the
recipient's email address.
The "send from" account is based on the default email account defined on your
device.
3. If you select "Share document," you can choose from any cloud storage app on your
device (iCloud, Dropbox, Box, etc.) to store an .rtf, Microsoft Word, .rtfd or .txt
copy of your dictation.
4. If you have the Microsoft Word app installed, you can choose the Open in
Word/Copy to Word options from the Share menu to have your dictated text opened
in Microsoft Word. You can then save your document from Microsoft Word.
Note: You can define a default email recipient for the Email Document command in the settings.
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Note: You can indicate the default format for sharing documents in the settings.

To transfer text to another app
Rather than sending your dictation as an email or a document, you may want to transfer
your dictated text to another app via the copy and paste functions available in your device's
operating system. This procedure is useful for replying to an email or an instant message or
pasting text into a workflow app.
1. Dictate the text you plan to transfer into another app.
2. Say "Transfer Text."
A confirmation message appears indicating your text has been copied.
3. Use your device's function to switch to the target app, such as double-tapping the
Home button.
4. Long-tap in the target app and choose Paste from the pop-up menu.

See also
Importing text or documents
Setting up sharing apps
Sharing with Evernote
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Setting up sharing apps
You can share your dictation by using cloud storage and communication apps installed on
your device.

Viewing your sharing apps
1. On the Dictation screen, tap the Share icon
.
2. Scroll to see all apps that accept shared content.
3. If the app you want to use is not present, tap More, enable the desired service and tap
Done.

See also
Sharing your dictation
Importing text or documents
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Saving dictation to Evernote
To save your dictation as a new note in Evernote, install the Evernote app on the same
device where Dragon Anywhere is installed and log in to your Evernote account. Dragon
Anywhere performs authentication through the Evernote app and does not store your credentials.

Saving to Evernote on iOS
1. When you are ready to share your dictated text to Evernote, say "Save to Evernote"
or choose the "Save to Evernote" item on the Share menu
on the Dictation
screen.
2. If Evernote requests you to authorize Dragon Anywhere to use your Evernote
account, select an authorization period and tap Authorize.
3. Specify a name for the new note.
By default, the note will use the name from the Title field on the Dragon Anywhere
Dictation screen.
4. Optionally enter a tag for the new note.
5. Select the notebook where you want to create the new note.
6. Tap Save.
You'll receive a confirmation message when your note has been saved.
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Saving to Evernote on Android
1. When you are ready to share your dictated text to Evernote, say "Save to Evernote"
2.
3.
4.
5.

or choose the "Save to Evernote" item on the Share menu
.
If Evernote requests you to authorize Dragon Anywhere to use your Evernote
account, select an authorization period and tap Authorize.
To save your first note, tap the Evernote elephant icon at the bottom of the Dictation
screen.
Select the notebook where you want to create the new note.
Optionally choose a tag for the note.

6. Tap the Evernote icon

.

You'll receive the confirmation checkmark when your note has been saved.
7. When saving subsequent notes, you can change the notebook and/or tag by tapping
the Evernote elephant icon while it is spinning. Make the desired changes and then
tap the Evernote icon again to save the note.

De-authorize Dragon Anywhere to use Evernote
Complete the following steps if you no longer want Dragon Anywhere to have access to
your Evernote account.
1. Open the Settings from the Sidebar.
2. Scroll to the Account section and tap, "Unlink Evernote."
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If you receive an error message when using this setting, please access the Evernote web site
and choose Account – Settings – Security - Applications. You can revoke Dragon Anywhere’s access to Evernote on any or all of your linked devices.
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Adding new words

Adding new words
Click
"Adding custom words" on the
next page

To learn about
How to improve accuracy by adding words specific to your work and industry.

"Importing custom words" on page Leverage custom words you have added to your
70
Dragon desktop products.
"Deleting custom and original
words" on page 71

Remove words from the vocabulary that you don't
want to have recognized.
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Adding custom words
You can improve recognition accuracy by adding words to the vocabulary that are specific
to your industry and subject matter. The words you add in Dragon Anywhere are uploaded
to the central management server. If you are using a version of Dragon Desktop or Dragon
for Mac that connects to the management server, these items will also be available in the
Dragon desktop products.
Watch a video tutorial on this topic.

To add a word in the Dictation window
If Dragon Anywhere mis-recognizes a word, use the keyboard to correct the word then
complete the following steps to add the corrected word to the recognition vocabulary.
1.
2.
3.
4.

Long-tap the word to display the Edit menu.
Tap Select.
Turn on the microphone and say, "Add that to the vocabulary."
If the way you say the word is different from the way it is spelled, enter the phonetic
representation of the word in the Spoken Form field.

For example:
Written form

NASA

Spoken form

Na Sa

If the written form contains non-alphabetic characters, you must enter a spoken form.
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To add words using the Words window
1.
2.
3.
4.

Open the Sidebar
and tap Words.
Tap the Plus icon .
Enter your word in the Written Form field.
If the way you say the word is different from the way it is spelled, enter the phonetic
representation of the word in the Spoken Form field, see above.

To import words
If you have custom words in Dragon desktop products or Dragon for Mac, you can import
them into Dragon Anywhere.
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Importing custom words
You can improve recognition accuracy by adding words to the vocabulary that are specific
to your industry and subject matter. You must be connected to the internet to import words.

To import words
If you have custom words in Dragon desktop products or Dragon for Mac, you can import
them into Dragon Anywhere.
1. To export your words from Dragon desktop products,
l

From the DragonBar, choose Vocabulary > Export Custom Word and
Phrase List.

2. To export your words from Dragon for Mac,
a. Choose Tools > Vocabulary Editor.
b. Select the words you want to export
c. From the Gear menu, choose Export.
3. Specify a location to save the exported file.
Choose a location accessible from your mobile device, such as DropBox or iCloud.
4. Open the Sidebar
and tap Words.
5. Tap the Plus icon
and choose Import Word List.
6. Select the file you exported from Dragon desktop products or Dragon for Mac.
A message appears indicating if any errors occurred during the import process.
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Deleting custom and original words
You can remove custom words you've added to the vocabulary as well as words included
in the original vocabulary. You may want to remove an original word if it is being recognized instead of another word you want to dictate.

To delete custom words
1. Open the Sidebar
and choose Words.
2. Tap Select and then tap the checkbox for each word you want to remove.
3. Tap Delete.
The word list is refreshed and the deleted words are no longer present.

To delete original words
You can delete original words while you're dictating or from the Words screen.
To delete words while you're dictating
1. When a word is recognized that you don't want to have recognized in the future,
select the word by voice or by long-tapping the word and choose Select from the
Edit menu.
2. Turn on the microphone and say, "Do not recognize that word."
3. On the Manage Words page, tap Delete.
4. Return to the Dictation screen and delete the word from your document.
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To delete words from the Words page
1.
2.
3.
4.
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Open the Sidebar
and choose Words.
Tap the Plus
icon.
Tap in the Written Form field and type the word you want to remove.
Tap Delete at the bottom of the screen.

Managing Auto-texts

Managing Auto-texts
Auto-texts are macros that allow you to generate a block of text by saying a single utterance. Auto-texts allow you to create more consistent documentation faster than typing or
dictating all of the text.
The auto-texts you add in Dragon Anywhere are uploaded to the central management
server. If you are using a version of Dragon desktop products or Dragon for Mac that connects to the management server, these items will also be available in the Dragon desktop
products.
You can use auto-texts to:
l
l
l
l

Insert your signature block
Generate a standard set of instructions
Insert a form that you complete by voice
Apply standardized assessment text

You can also import auto-texts from Dragon desktop products and Dragon for Mac.
Dragon Anywhere supports plain text in newly created and imported auto-texts.

Creating auto-texts
To view your available auto-texts, open the Sidebar

and tap Auto-texts.

To create auto-texts
1. Open the Sidebar
2. Tap the Plus icon

and tap Auto-texts.
.
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3. Enter the utterance you want to say to invoke the auto-text in the Spoken Form field.
You may want to include an action verb in the auto-text name. For example, if the
name of your auto-text is "Signature," you may choose to enter the spoken form
"Insert Signature." Adding an action verb improves the accuracy of auto-texts, particularly when the auto-text name is a single word.
4. Enter an optional description in the Written Form field. The description can help you
or other users understand or remember the purpose of the auto-text.
5. Enter your text in the Auto-text Content area.
6. Hide the keyboard.
7. Tap Save.

Rules for auto-text spoken forms
If the way you say the auto-text name is very different from how it's spelled, enter a spoken
form that represents the pronunciation. You can only use alphabetic characters in spoken
forms. For acronyms that are spelled out use capital letters, separated by spaces.
For the spoken form, do not use:
l
l
l
l
l
l
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Very short phrases (such as one syllable only)
Capital letters (except for acronyms, for example, C I A)
Abbreviations
Digits (use "twelve" instead of "12")
Punctuation marks (e.g., !, ?, :)
Symbols (e.g., +, *, $)

Managing Auto-texts

Using auto-text fields
If you're creating a form, you can add form fields to an auto-text by tapping the Insert Field
button. The "[ ]" characters will appear in the Content area. You can enter a description or
default value for the field, such as "[Date]" or leave the field empty.
When you say the spoken title of the auto-text, the form fields will appear in the document.
You navigate the form fields by saying "Next Input Field" and "Previous Input Field." To
accept the description or default value you specified for a field, say "Accept Default" when
the field is selected.

Using auto-texts during dictation
You can use auto-texts at any time when the focus is in the Body field on the Dictation
screen. To invoke the auto-text, say the name that you entered in the Spoken Form field on
the Manage Auto-texts page. You do not need to say additional words, such as "auto-text,"
"macro," or "create."
If your auto-text includes form fields, the first form field will be selected by default.
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Managing Auto-texts
Auto-texts are macros that allow you to generate a block of text by saying a single utterance. Auto-texts allow you to create more consistent documentation faster than typing or
dictating all of the text.
The auto-texts you add in Dragon Anywhere are uploaded to the central management
server. If you are using a version of Dragon desktop products or Dragon for Mac that connects to the management server, these items will also be available in the Dragon desktop
products.
You can use auto-texts to:
l
l
l
l

Insert your signature block
Generate a standard set of instructions
Insert a form that you complete by voice
Apply standardized assessment text

You can also import auto-texts from Dragon desktop products and Dragon for Mac.
Dragon Anywhere supports plain text in newly created and imported auto-texts.

Creating auto-texts
To view your available auto-texts, open the Sidebar

To create auto-texts
1. Open the Sidebar
2. Tap the Plus icon
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and tap Auto-texts.
.

and tap Auto-texts.

Managing Auto-texts

3. Enter the utterance you want to say to invoke the auto-text in the Spoken Form field.
You may want to include an action verb in the auto-text name. For example, if the
name of your auto-text is "Signature," you may choose to enter the spoken form
"Insert Signature." Adding an action verb improves the accuracy of auto-texts, particularly when the auto-text name is a single word.
4. Enter an optional description in the Written Form field. The description can help you
or other users understand or remember the purpose of the auto-text.
5. Enter your text in the Auto-text Content area.
6. Hide the keyboard.
7. Tap Save.

Rules for auto-text spoken forms
If the way you say the auto-text name is very different from how it's spelled, enter a spoken
form that represents the pronunciation. You can only use alphabetic characters in spoken
forms. For acronyms that are spelled out use capital letters, separated by spaces.
For the spoken form, do not use:
l
l
l
l
l
l

Very short phrases (such as one syllable only)
Capital letters (except for acronyms, for example, C I A)
Abbreviations
Digits (use "twelve" instead of "12")
Punctuation marks (e.g., !, ?, :)
Symbols (e.g., +, *, $)
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Using auto-text fields
If you're creating a form, you can add form fields to an auto-text by tapping the Insert Field
button. The "[ ]" characters will appear in the Content area. You can enter a description or
default value for the field, such as "[Date]" or leave the field empty.
When you say the spoken title of the auto-text, the form fields will appear in the document.
You navigate the form fields by saying "Next Input Field" and "Previous Input Field." To
accept the description or default value you specified for a field, say "Accept Default" when
the field is selected.

Using auto-texts during dictation
You can use auto-texts at any time when the focus is in the Body field on the Dictation
screen. To invoke the auto-text, say the name that you entered in the Spoken Form field on
the Manage Auto-texts page. You do not need to say additional words, such as "auto-text,"
"macro," or "create."
If your auto-text includes form fields, the first form field will be selected by default.
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Importing auto-texts
Import auto-texts from your Dragon desktop products to avoid having to dictate text you
use repeatedly, such as form or template data. You first export your auto-texts from the
desktop product and then import them into Dragon Anywhere. You must be connected to
the internet to import auto-texts.

To export auto-texts from Dragon desktop products
1. From the DragonBar choose Tools > Command Browser.
2. Click Manage.
3. Use the Group list to select the command group containing the text commands you
want to export.
Note: Dragon Anywhere supports plain text commands.
4. Click on the plus sign (+) to expand the list if needed to find the command(s) you
want to export.
5. Click the check box to the left of each command you want to export.
6. Click the Export button.
Note:When exporting auto-texts from Dragon desktop products, save the file in .xml
format. Save the file to a location you can access from your mobile device, such as
DropBox or Google Drive.
Note: If Dragon desktop products cannot write to the cloud storage location, save the
XML file to another location, such as the Desktop and then use Windows Explorer
to copy the XML file to your cloud service folder.
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To export auto-texts from Dragon for Mac
1. Choose File > Command Export.
2. Select the commands you want to export and click Export.
Save the exported files to a location accessible from your mobile device, such as
iCloud or Google Drive.
1. On the Dragon Anywhere Sidebar, select Auto-texts.
2. Tap Plus .
3. Select the cloud storage service where you saved the auto-texts in the export procedure.
Note: If you do not see your XML file in the list, choose the "Show All File Types"
option in the cloud storage app.
4. Select the auto-text file you want to import and tap Done.
A confirmation message appears with details on which auto-texts were imported successfully and if any errors occurred.
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Deleting auto-texts

Deleting auto-texts
1. Open the Sidebar
and tap Auto-texts.
2. Tap Select and then tap the auto-text(s) you want to delete.
3. Tap Delete.
l

Creating auto-texts
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Resolving Auto-text errors
When importing auto-text commands from Dragon desktop products, errors may occur.
Below are explanations for the most common errors.

Unsupported command types
Dragon Anywhere supports auto-text commands. Step-by-Step, Macro Recorder and
Advanced Scripting commands are not supported. If you select an XML file to import into
Dragon Anywhere that contains these unsupported command types, they will be ignored.

Text Formatting
Dragon Anywhere supports plain text auto-text commands. If you select an XML file to
import that contain rich text formatting, Dragon Anywhere will select the plain text version
of the command contained in the XML file.

82

Settings

Settings
Click

To learn about

Changing your password

Reset your login password.

Changing your dictation language

Select the language you want to use for dictation.

"Changing the text display size" on
page 86

Adjust the display size of your dictated text.

Managing import and sharing settings

Specify file formats, email recipient and messages for import/export operations.

"Logging in to Dragon Anywhere" on
page 88

Specify whether or not the Login screen is displayed when you launch the app.

Resetting the app and logging out

Log out or reset the app.

Contact Support

View our online knowledge base or contact a
support agent.
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Changing your password
You can change your password at any time.
1. Open the Sidebar , choose Settings and then choose Change Password.
2. Enter your current password and then your new password two times.
To create a strong password, we recommend including upper and lowercase letters, numbers and punctuation symbols. The colon mark (:) is not allowed in passwords.
l
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Setting login preferences

Manage import and sharing settings

Manage import and sharing settings
1. Open the Sidebar
and choose Settings.
2. Scroll to the Import/Export Settings section.
3. If you are working with Macintosh applications and need to output .rtfd files, turn on
the "Share in Mac TextEdit format" setting.
4. If you regularly import RTF files and receive warning messages about unsupported
content, you may choose to turn off the "Show document import warning" setting.
5. If you plan to send your dictated text in email to the same recipient, turn on the
"Default email recipient" setting and enter the recipient's email address.
l

Setting login preferences
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Changing the text display size
You can define the size of the text that appears when you dictate. The setting you choose
applies to all text in the Dictation screen. You can also change the text size while you're dictating by saying one of the following voice commands: "Set font size to Small | Medium |
Large"
1. Open the Sidebar , choose Settings and scroll to the Look and Feel section.
2. Choose a font size (Small, Medium or Large).
3. To see if your font size selection is satisfactory, switch to the Dictation screen and
dictate some text.
l
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Manage import and sharing settings

Manage import and sharing settings
1. Open the Sidebar
and choose Settings.
2. Scroll to the Import/Export Settings section.
3. If you are working with Macintosh applications and need to output .rtfd files, turn on
the "Share in Mac TextEdit format" setting.
4. If you regularly import RTF files and receive warning messages about unsupported
content, you may choose to turn off the "Show document import warning" setting.
5. If you plan to send your dictated text in email to the same recipient, turn on the
"Default email recipient" setting and enter the recipient's email address.
l

Setting login preferences
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Logging in to Dragon Anywhere
The Login screen appears each time you start the app. You will need to enter your password to proceed. You can choose to have the app remember your password on the Settings
screen. This will allow you to bypass the Login screen.
Note: If you explicitly log out of the app, the Login screen will appear the next time you
start the app.
1. Open the Sidebar , choose Settings and scroll to the Security section.
2. Turn on the Remember Password setting.
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Resetting the app and logging out

Resetting the app and logging out
You may choose to reset the app if you have many draft documents you want to clean up
quickly or if you're providing the device to another person to use. Resetting the app permanently removes all local copies of your documents. If you have shared documents to
cloud storage services, those shared copies will not be removed when to reset Dragon Anywhere. Resetting the app also changes all settings to their default values.
1. Open the Sidebar , choose Settings and scroll to the bottom of the screen.
2. Tap Reset Application and then tap Reset on the confirmation message.

Logging out of the app
You can leave Dragon Anywhere running between your dictation sessions. No communication occurs with our servers unless you are actively using the app. You may choose
to log out between sessions to secure your draft documents. If your documents contain sensitive data, we recommend you also define a pass code for your mobile device.
1. Open the Sidebar
and choose Settings.
2. Choose Logout.
3. Tap OK on the confirmation message.
You will be returned to the Login screen.
l
l

Changing your password
Setting login preferences
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Frequently asked questions
Click

To learn about

Do I have to enter my password
every time I launch or switch to
the app?

No, you can turn on the "Remember Password"
option on the Settings page.

How do I dismiss the keyboard
on my phone?

On phones held in portrait orientation, a Done link
appears in the upper-right-hand corner of the keyboard. If the Done link is not present, rotate your
phone into landscape orientate and then tap the Keyboard Dismiss button.

Is there a time limit for dictation?

No, you can dictate for as long as you want.

Is there a quick reference for com- Yes, tap the Commands List icon
on the Dictamon voice commands?
tion screen to see the most common commands.
Can multiple people dictate into
the app?

Yes. Each person who uses the app should have his
or her own account since each account has its own
speech recognition profile. See details.

Can I train words in the app?

No. As you dictate words, the system will adapt automatically to your pronunciation and word usage.

Do Dragon Anywhere and
Dragon desktop products share
the same speech recognition profile?

No. Dragon desktop products and Dragon Anywhere use separate speech recognition profiles. It's
possible to share custom words and auto-text commands between the products. See details.
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Frequently asked questions

Click
Can I use dictation modes, such
as Spelling and Numbers?

To learn about
No. Dragon Anywhere supports Dictation mode. If
you need to enter a word or acronym that is not
being recognized, please use the keyboard.

You can use any cloud storage service to share the
documents you create in Dragon Anywhere, as long
What cloud storage services can I
as the service is recognized on your mobile device.
use?
Popular cloud storage services include iCloud,
Google Drive, Drop Box, One Drive and Box.
How do I buy multiple copies of
the app for a group of users?

Yes. See our corporate sales page for details.
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Frequently asked questions
Click

To learn about

Do I have to enter my password
every time I launch or switch to
the app?

No, you can turn on the "Remember Password"
option on the Settings page.

How do I dismiss the keyboard
on my phone?

On phones held in portrait orientation, a Done link
appears in the upper-right-hand corner of the keyboard. If the Done link is not present, rotate your
phone into landscape orientate and then tap the Keyboard Dismiss button.

Is there a time limit for dictation?

No, you can dictate for as long as you want.

Is there a quick reference for com- Yes, tap the Commands List icon
on the Dictamon voice commands?
tion screen to see the most common commands.
Can multiple people dictate into
the app?

Yes. Each person who uses the app should have his
or her own account since each account has its own
speech recognition profile. See details.

Can I train words in the app?

No. As you dictate words, the system will adapt automatically to your pronunciation and word usage.

Do Dragon Anywhere and
Dragon desktop products share
the same speech recognition profile?

No. Dragon desktop products and Dragon Anywhere use separate speech recognition profiles. It's
possible to share custom words and auto-text commands between the products. See details.
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Frequently asked questions

Click
Can I use dictation modes, such
as Spelling and Numbers?

To learn about
No. Dragon Anywhere supports Dictation mode. If
you need to enter a word or acronym that is not
being recognized, please use the keyboard.

You can use any cloud storage service to share the
documents you create in Dragon Anywhere, as long
What cloud storage services can I
as the service is recognized on your mobile device.
use?
Popular cloud storage services include iCloud,
Google Drive, Drop Box, One Drive and Box.
How do I buy multiple copies of
the app for a group of users?

Yes. See our corporate sales page for details.
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Getting help
If you encounter a problem that is not covered by the documentation, please consult these
sources for assistance.
Support site
Contact Technical Support
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Copyrights

Copyrights

EVERNOTE, the Evernote Elephant logo and REMEMBER EVERYTHING are trademarks of Evernote Corporation and used under a license.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG,
Inc. and any use of such marks by Nuance Communications, Inc. is under license.
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